MotiveWave™
Docking Framework
Version: 1.0

©2019 MotiveWave™ Software
# Table of Contents

1  Introduction  
   1.1  Elements  
   1.2  Desktops  

2  Stations  
   2.1  Station Tool Bar  
   2.2  Pop Out Panels  
   2.3  Reorder Tabs  
   2.4  Creating New Panels  
   2.5  Active Stations  
      2.5.1  Active Chart Station  
      2.5.2  Active Focus  

3  Pages  
   3.1  Adding a Page  
   3.2  Edit a Page  
   3.3  Copy Page  
   3.4  Re-order Pages  
   3.5  Overflow Tabs  

4  Layouts  
   4.1  Split Layouts  
      4.1.1  Moving Panels Between Stations  
      4.1.2  Custom Split Layouts  
   4.2  Floating Stations  
      4.2.1  Moving Stations  
      4.2.2  Resizing Stations  
      4.2.3  Sticky Edges  
      4.2.4  Resizing Snapped Stations  
      4.2.5  Minimizing Stations  
      4.2.6  Maximizing Stations  
      4.2.7  Creating New Stations  
      4.2.8  Moving Panels Between Stations  
      4.2.9  Closing/Removing Stations  
   4.3  Managing Floating Stations  
      4.3.1  Tile Stations  
      4.3.2  Cascade Stations  
      4.3.3  Station Sizes  
      4.3.4  Station Access  

5  Customization  
   5.1  Active Tab Bar Colors
1 Introduction

Welcome to the MotiveWave™ Docking Framework Guide! If you are reading this document then you have already installed MotiveWave™ on your computer and you are ready to start using the application.

If you have not yet installed MotiveWave™ or registered for a trial on our website, please read the Installation Guide before continuing on with this document.

The MotiveWave Docking Framework provides a flexible system to manage multiple panels (such as charts, watch lists etc) within a single application window. This document will outline and explain the features associated with this framework.

1.1 Elements

When you first open a workspace in MotiveWave™ the console will be displayed with the default layout. Depending the broker/data service(s) you added to the workspace, the console window will look similar to the screen shot below:

The console has a number of elements outlined below. These elements will be explored in detail in this document.

1. Stations – Stations contain one or more panels (charts, watch lists, etc) stacked on top of each other. The panels are directly accessible from the tabs in the top tab bar.

2. Pages – Pages contain one or more stations arranged in a layout. An application window (Console or Desktop) may contain multiple pages that are accessible from the page tabs at the bottom of the window.
3. **Layouts** – Stations are arranged within the page using a layout. Two types of layouts are supported: Split Layouts and Floating Station layouts.

### 1.2 Desktops

The examples provided in this document are from the Console window (main application window). The Professional and Ultimate editions also provide Desktop windows that use the docking framework. Desktops may be created/accessed from the Console menu bar (File -> New -> New Desktop and File -> Open -> Open Desktop):
2 Stations

A station holds one or more panels stacked and accessible from tabs at the top of the station. The screen shot below outlines some of the elements in a typical station:

2.1 Station Tool Bar

The station will display a tool bar that is specific to the active panel (if one is defined for the panel). In the case below the watch list tool bar is displayed:

2.2 Pop Out Panels

A panel can be “popped out” into a separate application window by clicking the pop out button on right side of the tab bar. The original panel stays in the station and a copy of that panel is opened in a separate application window. Application windows can be managed from the Window menu in the top menu bar.
2.3 Reorder Tabs

The tabs in the station can be reordered by dragging them with the mouse (left click and hold while moving the mouse). A vertical blue bar highlights the location where the tab will be placed after releasing the mouse button.
After releasing the mouse button the tab is dropped at the given location. The tab is made the active tab in the station.

2.4 Creating New Panels

A new panel may be created by click on the + button to the right of the last tab in the station. Several different types of panels are available (depending on the edition of MotiveWave™).

The new panel tab will be added to the end of the list of tabs in the tab bar:
2.5 Active Stations

The color of the tab bar will change if it is the active station. There are two types of active stations:

1. Active Chart – This station contains the active chart for the tool bar(s).
2. Active Focus – This station has the current input focus.

2.5.1 Active Chart Station

The tab bar for the station that contains the active chart will have a light blue color (dark blue in the Dark Window theme). The highlight visually indicates which chart the tool bar is currently associated with. Contextual settings for these controls reflect the active chart (such as quick search symbol, bar size, auto scale etc). All of the actions (buttons, drop downs etc) in the tool bar will apply to the active chart.

2.5.2 Active Focus

In cases where the active station is not the active chart station the tab bar will have a subtle blue color to indicate that it has the input focus.
3 Pages

Pages provide a convenient way to manage a virtually unlimited number of panels (charts, watch lists, gauges etc) in different layouts. The page bar at the bottom of the Console window is initially configured with several preset pages. Left click on a page tab to show the layout in the content section of the window. In the default layout you will see the following pages:

1. **Home** – Contains a sample home layout with a chart section and two watch list sections on the bottom.
2. **Charts** – Sample chart layout with six charts (2 rows, 3 columns)
3. **Account** – Account related panels including Accounts, Orders, Positions and Trade History
4. **Scan** – Sample layout for running a scanner and viewing the results in a chart
5. **Optimize** – Simple layout with the Back Test/Optimize panel.

The screenshot below shows the page bar (at the bottom of the console window) and highlights some of the features.

### 3.1 Adding a Page

Click on the New Page Button (+ button to the right of the last page tab). This will show the New Page dialog:
The New Page dialog requires a name for the page (displayed in the tab) and a layout. Layouts are arranged in categories:

1. **Chart** – Typical chart layouts. Some include watch lists and or account/order/position/trades panels.
2. **Account** – Some account management layouts. Layouts include account, order, position, trades and watch lists panels.
3. **Scan** – Layouts for performing scans (on Studies, Elliott Waves or Harmonic patterns).
4. **Optimize** – Layouts for optimizing/back testing strategies
5. **Floating** – Layout for floating stations.

An icon is displayed on the left side of the tab to indicate the category of the layout. The screen shot below shows the new page added to the page bar (and active).

### 3.2 Edit a Page

Click on the Edit Page button (right side of the page bar) to change the name and/or layout of the active page:
The screen shot below shows the changes made to the page.
3.3 Copy Page

In some cases, it may be convenient to copy an existing page instead of creating a new one. When a page is copied the existing layout is copied including all of the stations and panels.

Click on the Copy Page button on the right side of the page bar.

The screen shot below shows the copied page added to the page bar:
3.4 Re-order Pages

Page tabs can be re-ordered by clicking/dragging a tab to the desired location. As you drag the tab a vertical blue bar will appear that indicates where the tab will be placed.

3.5 Overflow Tabs

There is no limit to the number of page tabs you can have. If there is not enough space to display the tabs, an overflow button will appear with the number of unseen tabs in the label.
4 Layouts

There are two types of layouts available:

1. **Split Layouts** – All of the pages in the default layout use split layouts. In these layouts there is one or more stations that are separated by horizontal/vertical splits.
2. **Floating Stations** – In this layout the stations have absolute locations and sizes. Stations can be sized and positioned individually.

4.1 Split Layouts

Split layouts use one or more splits (or dividers) to arrange stations on a page. Splits can be horizontal (dividing the available width between two more stations) or vertical (dividing the available height between two or more stations).

Splits set the relative size of the stations (ie a percentage of the window size instead of an absolute size in pixels). If the size of the application window changes (either from maximizing or manual resizing) the change in size will be distributed across all of the splits.

Splits can also be nested inside of other splits allowing for a flexible and diverse set of layout possibilities.

The screen shot below shows the two splits in the default layout (highlighted in yellow). The vertical split will adjust the relative heights of the stations. The horizontal divider will adjust the relative widths.

4.1.1 Moving Panels Between Stations

Panels can be moved between stations by clicking/dragging the tabs with the left mouse button. Drag the tab to the center of the station to where you want it moved and release the mouse button. The target station will be highlighted in blue (see below).
The panel will be added to the target station (see below) and made the active station. You will see a new tab in the station placed to the right of the previously active station.
4.1.2 Custom Split Layouts

There are many built in layouts for you to choose from in the New/Edit Page dialogs, but you can also create your own custom layout by arranging the stations using the mouse.

Left click and drag any of the station tabs to move a panel into an existing station or to create a new station.

In the screen shot below, the YMZ19 chart panel is dragged into a new station that splits the current chart station horizontally.

The screen shot below shows the new station created that splits the area occupied by the original chart station with a horizontal split.
In the screen shots below another panel is created (Gauges) and is dragged into a nested vertical split with the stations that we created in the previous example.
4.2 Floating Stations

Floating stations provide an alternative to split layouts. In contrast, the stations have fixed locations and sizes. The stations may also overlap other stations similar to application windows.

Unlike split layouts, resizing the window (or maximizing it) does not affect the sizes or positions of the stations. Resizing may also cause a station to no longer be visible if its original position lies outside of the new bounds of the visible area.

A floating station layout can be chosen when creating a new page or editing an existing page (see below).
The default layout for floating stations includes two overlapping stations in the top left section of the content area:

4.2.1 Moving Stations

Stations can be moved (positioned) by clicking/dragging the empty section of the tab bar. The stations can be placed anywhere, but must be at least partially visible in the content area.
4.2.2 Resizing Stations

Similar to application windows, stations may be resized by dragging the corners or edges of the stations.
4.2.3 Sticky Edges

For convenience, the edges of the stations and the visible bounds of the content area are “sticky”. This effect will cause the station to “snap” to the edge of another station or to the edges/corners of the visible bounds when the station is dragged or resized. The feature makes it easier to layout the stations.

The sticky option can be disabled by holding down on the Alt key when dragging or resizing a station.

When resizing an edge of station, it will snap to the edge of a near by station as well. This can be especially convenient when attempt to make the dimension of the stations the same. In the screen shot below the height of the station is made to match the height of the adjacent station when resizing from the bottom edge.
4.2.4 Resizing Snapped Stations

For convenience resizing the top, bottom or sizes of a station that has been snapped to another station will resize those station(s) as well. This behavior can be turned off by holding down on the Alt key.

4.2.5 Minimizing Stations

Stations can be minimized to clear clutter from the content area. Click on the minimize button in the top right corner of the station to minimize it.

The active tab of the minimized station will appear in the bottom left section of the content area appearing in the order in which they were minimized. Click on a minimized station to restore it to the content area.
4.2.6 Maximizing Stations

A station may be maximized to occupy the entire viewing area. When a station is maximized its size will change when the window is resized. When the station is restored, its original location and size will be preserved.

The left and right arrow buttons in the top right corner of the maximized station may be used to cycle through the stations in the viewing area.
4.2.7 Creating New Stations

There are several ways to create new stations:

1. **New Station (+) Button** – Click on the ‘+’ button on the right side of the page bar
2. **Context Menu** – Right click in an open section of the content area
3. **Top Menu Bar** – See **New Station** menu in the Dock section of the top menu bar.
4. **Dragging Station Tabs** – Station tabs can be dragged into an open section of the content area.

The following screen shots illustrate the first 3 options for accessing the New Station menu. This menu contains the available panel types similar to the new panel button in the tab bar of a station. Select the desired panel type to create a new station.
In the screen shot below a new Gauge panel was created resulting in a new station being added to the layout.

Alternatively, a new station may be created by dragging the tab of an existing panel from its station into an empty section of the content area.
When the mouse button is released in an empty section of the content area, a new station is created and the panel from the originating station is removed and added to the new station.

4.2.8 Moving Panels Between Stations

Panels can be moved from one station to another by dragging the tab (left click and drag with the mouse) into the content area of another station.
4.2.9 Closing/Removing Stations

A station is removed when the last panel is removed from the station. This will occur when the last station is either closed or moved into another station.

4.3 Managing Floating Stations

The Dock (top menu bar, only visible from a Floating Station layout) and Context Menus (right click) have several options for managing stations in the floating layout:

1. **Tile Stations** – Positions and resizes visible stations into a grid layout
2. **Cascade Stations** – Arranges and resizes stations from the top left corner of the visible area
3. **Restore Stations** – Restores all stations from the minimized state
4. **Minimize All** – Minimizes all visible stations
5. **Station Size** – The menu provides preset size (dimension) options
6. **Station Access** - All visible and minimized stations may be accessed directly from this menu

### 4.3.1 Tile Stations

This option will position and size all of the non-minimized stations into a grid format with the last station occupying the remaining space on the bottom row. Choose **Dock -> Tile Stations** from the top menu bar.

![Image of Tile Stations]

### 4.3.2 Cascade Stations

Arranges the non-minimized stations from the top left corner of the content area and offsets them by a few pixels so the tab labels are visible.

![Image of Cascade Stations]
4.3.3 Station Sizes

Several preset station sizes are available under the Station Size sub menu. A custom size can be chosen from a dialog (see Custom Size option). For convenience the active station size can be saved as the default size when new stations are created.
4.3.4 Station Access

All stations in the layout are listed at the bottom of the Dock menu. This provides a convenient way to locate a station that is minimized, hidden behind a set of station or is outside of the visible area.
5 Customization

Customization options can be found in the Preferences dialog (Configure -> Preferences from the Console menu bar). Click on General, then on Dock. The following options are available:

1. **Tab Location** – Location of the station tabs (top or bottom)
2. **Page Bar Location** – Location of the page bar (top or bottom)
3. **Show Tab Icons** – Optionally displays the icons for the station tabs. These icons indicate the panel type.
4. **Confirm Remove Page** – Shows a warning message when deleting a page (on by default).

The screen shot below shows the console window with the station tabs at the bottom, page bar at the top and station tab icons enabled.
5.1 Active Tab Bar Colors

The colors for the active chart and active focus can be customized from the Preferences dialog (Configure -> Preferences from the Console menu bar). Click on the Theme tab, then on the Theme sub tab:

The screen shot below shows the customized colors: